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SOLIDWORKS® 2019 Tutorial

Overview of SOLIDWORKS® and the User Interface

Chapter 1

Overview of SOLIDWORKS® 2019 and the User Interface
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Below are the desired outcomes and usage competencies based on the completion of

Chapter 1.

Desired Outcomes:

Usage Competencies:

e A comprehensive
understanding of the
SOLIDWORKS® 2019 User
Interface (UI) and
CommandManager.

Ability to establish a SOLIDWORKS session.

Aptitude to utilize the following items: Menu
bar toolbar, Menu bar menu, Drop-down
menus, Context toolbars, Consolidated drop-
down toolbars, System feedback icons,
Confirmation Corner, Heads-up View toolbar,
Document Properties and more.

Open a new and existing SOLIDWORKS part.

Knowledge to zoom, rotate and maneuver a
three button mouse in the SOLIDWORKS
Graphics window.
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Notes:
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Chapter 1 - Overview of SOLIDWORKS® 2019 and the User Interface

Chapter Objective

Provide a comprehensive understanding of the SOLIDWORKS® default User Interface
and CommandManager: Menu bar toolbar, Menu bar menu, Drop-down menu, Right-
click Pop-up menus, Context toolbars/menus, Fly-out tool button, System feedback icons,
Confirmation Corner, Heads-up View toolbar and more.

On the completion of this chapter, you will be able to:

e Utilize the SOLIDWORKS Welcome dialog box.

e Establish a SOLIDWORKS session.

e Comprehend the SOLIDWORKS 2019 User Interface.

e Recognize the default Reference Planes in the FeatureManager.
e Open a new and existing SOLIDWORKS part.

e Utilize SOLIDWORKS Help and SOLIDWORKS Tutorials.

e Zoom, rotate and maneuver a three button mouse in the SOLIDWORKS Graphics
window.

What is SOLIDWORKS®?

e SOLIDWORKS® is a mechanical design automation software package used to build
parts, assemblies and drawings that takes advantage of the familiar Microsoft®™
Windows graphical user interface.

e SOLIDWORKS is an easy to learn design and analysis tool (SOLIDWORKS
Simulation, SOLIDWORKS Motion, SOLIDWORKS Flow Simulation,
Sustainability, etc.), which makes it possible for designers to quickly sketch 2D and
3D concepts, create 3D parts and assemblies and detail 2D drawings.

e Model dimensions in SOLIDWORKS are associative between parts, assemblies and
drawings. Reference dimensions are one-way associative from the part to the drawing
or from the part to the assembly.

e This book is written for the beginner to intermediate user.
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Start a SOLIDWORKS 2019 Session

Start a SOLIDWORKS session and familiarize yourself with the SOLIDWORKS User
Interface. As you read and perform the tasks in this chapter, you will obtain a sense of how to
use the book and the structure. Actual input commands or required actions in the chapter are
displayed in bold.

The book does not cover starting a SOLIDWORKS session in detail for the first time. A
default SOLIDWORKS installation presents you with several options. For additional
information, visit http:/www.SOLIDWORKS.com.

Activity: Start a SOLIDWORKS 2019 Session.

Start a SOLIDWORKS 2019 session.
1) Type SOLIDWORKS in the Search window.

&R My stuff £ Web
2) Click All Programs.
SOLIDWORKS
3) Click the SOLIDWORKS 2019 application (or if available,
double-click the SOLIDWORKS icon on the desktop). Best match =

The SOLIDWORKS Welcome dialog box is displayed by ~_u o
SOLIDWORKS
default. B L SOLIDWORKS

SN0 TO -

The Welcome dialog box provides a

convenient way to open recent documents Homs " Recent | Lzam| Alers
(Parts, Assemblies and Drawings), view
recent folders, access SOLIDWORKS
resources, and stay updated on
SOLIDWORKS news. Recent Dciients Views

LENS.SLDPRT Advanced Button 16... Slot Mate 11-1.5LDA Screw Mate 11-1 SL.. Pattern Driven Com.

New

@ part @ Assembly B8 Drawing Advanced. ¥ Open

4) View your options. Do not open a ) ’
document at this time. Q) 4 ,@? ,J ,@
g g g g G

5) If the Welcome dialog box is not
displayed, click the Welcome to

Recent Folders View all Resources
SOLIDWORKS @ icon from the ) SOLIDWORKS 2013 T Afitaions
. C:\Users\Davepl\Documents\2019 SOLIDWORKS Reference ...
Standard toolbar or click Help > = [t —— Hyselidorks e
Welcome to SOLIDWORKS from the T N B SepaiaBetalons [
Maln menu. @ Arrow keys rotate the model. Ctr + Arrow Keys pan the model. Alt + Arrow Keys rotate the model clockwise and counterclockwise. < >
[0 Do not show on startup.
T ;
s

ﬁ Welcome to SOLIDWORKS Ctrl+F2 @
(2) SOLIDWORKS Help

PAGE 1-4
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ome Recent Learn lerts
Home Tab e
The Home tab lets you open new and existing Ko Wy Woay SRR By opn
documents, view recent documents and folders, | sntoomn.
and access SOLIDWORKS resources (Part, ’ ) ' o
Assembly, Drawing, Advanced, Open). o N ~ ¢ 4 o % .
Recent Tab Recent Folders View all Resources
LY — Y-
The Recent tab lets you view a longer list of BT oo TSl @ st
. . Test % Beta Forum (@ Report a Beta Issue

recent documents and folders. Sections in the A L 5
Recent tab include Documents and Folders. e
The Documents section includes thumbnails of | fore fet eon 2o
documents that you have opened recently. - —
Click a thumbnail to open the document, or G S ST
hover over a thumbnail to see the document Q i 8 o 4 o . | £ o
location and access additional information
about the document. When you hover over a E > P : P
thumbnail, the full path and last saved date of ¢ 9 °
the document appears.
Learn Tab .

[0 0o not show on startup.

The Learn tab lets you access instructional
resources to help you learn more about the
SOLIDWORKS software.

Sections in the Learn tab include:

Home  Recent LEarn Alerts

Introducing SOLIDWORKS Tutorials MySolidWorks Training

+ SOLIDWORKS Fundamentals

¢ Introducing SOLIDWORKS. Opens the v s g
Introducing SOLIDWORKS book. ' 1

+ Unlimited 24/7 access

samples

e Tutorials. Opens the step-by-step tutorials
in the SOLIDWORKS software. _ _

e  MySolidWorks Training. Opens the > @ ® &
Training section at MySolidWorks.com.

e Introducing SOLIDWORKS (Samples).
Opens local folders containing sample
models.

@ online Tutorials & My Training R Certification # Curriculum

e Tutorials (Samples). Opens the
SOLIDWORKS Tutorials (videos) section
at solidworks.com.

e  What’s New (Samples). List of new changes.
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SOLIDWORKS® 2019 Tutorial

e 3DContentCentral. Opens 3DContentCentral.com.

e My Training. Opens the My Training section at MySolidWorks.com.

e Certification. Opens the SOLIDWORKS Certification Program section at

solidworks.com.

e Curriculum. Opens the Curriculum section at solidworks.com.

w s

¥ When you install the software, if you do not install the Help Files or Example Files, the

Tutorials and Samples links are unavailable.

Alerts Tab

The Alerts tab keeps you updated with
SOLIDWORKS news.

Sections in the Alerts tab include Critical,
Troubleshooting, and Technical.

R

NS The Critical section does not appear if
there are no critical alerts to display.

e Troubleshooting. The Troubleshooting
section includes troubleshooting messages
and recovered documents that used to be
on the SOLIDWORKS Recovery tab in
the Task Pane.

w s

“¥" If the software has a technical problem
and an associated troubleshooting message
exists, the Welcome dialog box opens to the
Troubleshooting section automatically on
startup, even if you selected Do not show at
startup in the dialog box.

e Technical Alerts. The Technical Alerts
section opens the contents of the
SOLIDWORKS Support Bulletins RSS
feed at solidworks.com.

Close the Welcome dialog box.

6) Click Close * from the Welcome dialog
box. The SOLIDWORKS Graphics window is
displayed.

Home Recent Learn AIeE's

Technical Alerts

SOLIDWORKS 2018 SP3.0 EV (Early Visibility) is available online to run from your browser
Thu, 19 Apr 2018 16:12:43 EST
SOLIDWORKS 2018 SP3.0 EV (Early Visibility) is available for download

18 13:59:40 EST

SOLIDWORKS 2018 SP2.0 is available for download
Tue, 06 Mar 2018 16:38:21 EST

Activation System Downtime on March 3, 2018 between 5 am and 6 pm EST for Maintenance
Wed, 14 Feb 2018 08:30:15 EST
SOLIDWORKS 2018 SP1.0 is available for download

Tue, 09 Jan 2018 150338 EST

SOLIDWORKS 2017 SP5.0 is available for download
Tue, 21 Nov 2017 16:39:44 EST

Scheduled Maintenance Friday
Wed, EsT

Recent Folders

El simulation
C:\Users\Public\Documents\SOLID]
El Manuals
C\Program Files\SOLIDWORKS Co

= Final models“

@ Arrow keys rotate the model. Ctrl + Arr

%DD not show on startup

A
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View the SOLIDWORKS Graphics window.

JI%SOLIDWORKS File View Tools Help f‘ @ v@v - - e o 8 ?2-_ 0O ><

SOLIDWORKS =
Tools
Property Tab

Welcome to
\% 2 SOLIDWORKS
L)

Builder

@, SOLIDWORKS Rx

Benchmark Test

Compare My Score

Performance
=]

2
2S SOLIDWORKS' s

20 79 B \yizard

% My Products

Online Resources ~
3DEXPERIENCE
Marketplace

' Partner Solutions

Subscription
Services

& Subscription WV

If you do not see this screen, click the SOLIDWORKS Resources o | Q-8 ?-_ =X
icon on the right side of the Graphics window located in the Task

Pane. & Welcome to SOLIDWORKS

7) Hover the mouse pointer over the SOLIDWORKS icon. oo
@ Property Tab Builder

@ SOLIDWORKS Rx

m @ Performance Benchmark Test
@ Compare My Score

R Copy Settings Wizard

8) Pin * the Menu Bar toolbar.

9) View your options from the Menu bar menu: File, View, Tools, and
Help.

‘%SOLIDW%KS 4 File View Tools Help -

J D7SSOLIDWORKS File View Tools Help @ v@v - - - - é’é"}-
/
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Menu Bar toolbar

The SOLIDWORKS (UI) is designed
to make maximum use of the Graphics window. The Menu
Bar toolbar contains a set of the most frequently used tool
buttons from the Standard toolbar.

»

AD-FE-8-9N0ES

2
DS SOLIDWORKS

@ Search Knowledge Base Q' ? - — D ><|

The following default tools are available:

e  Welcome to SOLIDWORKS O Opens the Welcome dialog box, New L - Creates a
new document; Open arg8 Opens an existing document; Save & - Saves an active

document; Print =1 Prints an active document; Undo = Reverses the last action;

Select o Selects Sketch entities, components and more; Rebuild @ - Rebuilds the
active part, assembly or drawing; File Properties E= - Shows the summary information

on the active document; and Options deAg Changes system options and Add-Ins for
SOLIDWORKS.

Menu Bar menu

Click SOLIDWORKS in the Menu Bar toolbar to 975 SOLIDWORKS | Fie View Tooks Help
display the Menu Bar menu. SOLIDWORKS -
provides a context-sensitive menu
structure. The menu titles remain the 1775 SOLIDWORKS[\! Fle Edit View Insert Tools Window Help 8
same for all three types of ~ '
documents, but the menu items change depending on which type of document is active.

Example: The Insert menu includes features in part documents, mates in assembly
documents, and drawing views in drawing documents. The display of the menu is also
dependent on the workflow customization that you have selected. The default menu items for
an active document are File, Edit, View, Insert, Tools, Window, Help and Pin.

The Pin * option displays the Menu bar toolbar and the Menu bar menu as illustrated.
Throughout the book, the Menu bar menu and the Menu bar toolbar are referred to as the
Menu bar.

%SOLIDWORKS & File View Tools Help 44

‘%SOLIDWORKS[JE‘ File Edit View Insert Tools Window Help 48

JD%SOLIDWORKS File Edit View Insert Tools Window Help ﬂ @ '|21/" E' ' {é\}"
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Drop-down menu

SOLIDWORKS takes advantage of the familiar Microsoft® Windows
user interface. Communicate with SOLIDWORKS through drop-down
menus, Context sensitive toolbars, Consolidated toolbars or the
CommandManager tabs.

w1

% £ A command is an instruction that informs SOLIDWORKS to
perform a task.

To close a SOLIDWORKS drop-down menu, press the Esc key. You
can also click any other part of the SOLIDWORKS Graphics window
or click another drop-down menu.

Create a New Part Document

In the next section create a new part document.

Overview of SOLIDWORKS® and the User Interface

File Edit View Insert Tools Window Help >
Ctrl+N

Ctrl+O

New...

¥ Open..

Open Recent
¥ Open Drawing
[ Close
58 Make Drawing from Part
49 Make Assembly from Part

& save

B savens.
@ savenn

Page Setup...
9) Print Preview...

& Print..

2P Print3D..

Z@ Publish to eDrawings

Ctrl+wW

Ctrl+S

Ctrl+P

™ Pack and Go...
Send To..

& Reload..

Find References...
Properties...

Exit

Customize Menu

Activity: Create a new Part Document.

A part is a 3D model, which consists of features. What are

features?

¢ B RI¢/@FT
g

Features are geometry building blocks.

% TRIANGLE (Default<<Defaults |

Most features either add or remove material.
Some features do not affect material (Cosmetic Thread).

Features are created either from 2D or 3D sketched profiles or
from edges and faces of existing geometry.

Features are individual shapes that combined with other features
make up a part or assembly. Some features, such as bosses and
cuts, originate as sketches. Other features, such as shells and
fillets, modify a feature's geometry.

Features are displayed in the FeatureManager as illustrated
(Boss-Extrudel, Cut-Extrudel, Cut-Extrude2, Mirrorl, Cut-
Extrude3 and CirPatternl).

“¥" The first sketch of a part is called the Base Sketch. The
Base sketch is the foundation for the 3D model. The book
focuses on 2D sketches and 3D features.

R
N
N
N

History

Sensors

Design Binder

Annotations

Solid Bodies(1)

Equations

25 Material <not specified>

Ej Front Plane

m Top Plane

ﬂ] Right Plane

I_. Origin

@ Boss-Extrude1
C Sketch1

Cut-Extrude1
C Sketch2

Cut-Extrude2
C Sketch3

[ﬁlﬂ Mirror1

Cut-Extrude3

C Sketch4

A .
B CirPattern1

-

-

v

v
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There are two modes in the New
SOLIDWORKS Document dialog
box: Novice and Advanced. The
Novice option is the default option
with three templates. The
Advanced mode contains access to
additional templates and tabs that
you create in system options. Use
the Advanced mode in this book.

Create a new part.

10) Click New D from the Menu
bar. The New SOLIDWORKS
Document dialog box is
displayed.

Select the Advanced mode.

11) Click the Advanced button as
illustrated. The Advanced mode
is set.

12)
13)

Click the Templates tab.

Click Part. Part is the default
template from the New
SOLIDWORKS Document
dialog box.

Click OK from the New
SOLIDWORKS Document
dialog box.

14)

w s

SOLIDWORKS® 2019 Tutorial

New SOLIDWORKS Document

Advance&

a3D arrangement of parts and/or other ~ a 2D eng

Drawing

®

Assembly

ineering drawing, typically of a
sssss blies part or assembly

OK Cancel Help

New SODWORKS Document

Templates  Tutorial MBD

Part
Assembly
Drawing

Advanced mode

] =]

Preview

Novice

Cancel Help

A [Mlustrations may vary depending on your SOLIDWORKS version and operating system.

The Advanced mode remains selected for all new documents in the current SOLIDWORKS
session. When you exit SOLIDWORKS, the Advanced mode setting is saved.

The default SOLIDWORKS installation contains three tabs in the New SOLIDWORKS
Document dialog box: Templates, Tutorial and MBD. The Templates tab corresponds to the
default SOLIDWORKS templates. The Tutorial tab corresponds to the templates utilized in
the SOLIDWORKS Tutorials. The MBD tab corresponds to the templates utilized in the
SOLIDWORKS (Model Based Definition).
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Part1 is displayed in the FeatureManager and is the name of the document. Part1 is the default
part window name.

The Part Origin J“ is displayed in blue in the center of the Graphics window. The Origin
represents the intersection of the three default reference planes: Front Plane, Top Plane and
Right Plane. The positive X-axis is horizontal and points to the right of the Origin in the Front
view. The positive Y-axis is vertical and points upward in the Front view. The

FeatureManager contains a list of features, reference geometry, and settings utilized in the
part.

w1

MKS (meter, kilogram, second)
“¥" Edit the document units directly from the Graphics window as e
illustrated.

IPS (inch, pound, second)

Edit Document Units.

Editing Part MMGS ) 7

/ Main Menu Toolbar

S SOLIDWORKS  File Edit View Insert Tools Window Help xl ADPFE-2- [0 B rai @ B search commans Q-8 ?2-_0OX
g & /-0-v-a@ ) Z =
Sketch  Smart o o o Convert o Rapid |Instant2D
Dimension| ) D-O-A Entities e
- - -& - om| - o . N
Features | Sketch | Evaluate | MBD Dimeggions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM | a0
. \ PLAPEE U © R =
& Blo e jm; @z\(l)eiwcgvmvi):m
g Default CommandManager 5
g Part1 (Defauit<<Defauit>. Heads-up View Toolbar = 'SOLIDWORKS
History Tools
| @ Property Tab Builder
@Sen‘sors ‘ Task Pane
> @ Design Binder Part FeatureManager e @ SOLIDWORKS Rx
> E]Annctations Performance
[0 Equations \i Benchmark Test
o— i " @ Compare My Score
87 Material <not specified> )
L Copy Settings
Q Front Plane L %Wizard
(] Top Plane A My Products
CJ Right Plane
I_. Origin X Online Resources  ~
Hide/Show @ SDEPERIENCE
FeatureManager tab Origin e
¥ Partner Solutions
Subscription N
. Services
y / Triad @ Subscrption
Services
)“X
< > | *Trimetric

- el ‘ 3D Vieys ‘ Motion Stl?'l ‘
ISOLIDWORK$Premium 201 Editing Part /MMGS - ’

Model Mode 3D Views Motion Mode Units Tags
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View the Default Sketch Planes.

15)
16)
17)
18)

Click the Front Plane from the FeatureManager.
Click the Top Plane from the FeatureManager.

Click the Right Plane from the FeatureManager.

SOLIDWORKS® 2019 Tutorial

Click the Origin from the FeatureManager. The Origin is the intersection of the Front, Top, and

Right Planes.

E & &

Section Sensor Performance
Properties Evaluation

|
T ©0 &
Design |nterference Measure Markup
Study  Detection View

JM File Edit View Insert Tools Window Help % | 7 -@vvv“’)v .8 ?2-_0OX

Zebra Stripes

@ Import Diagnostics Curvature

------- T
ﬂ Top Plane

[Ej Right Plane

I_, Origin

< >

Y

P

*Trimetric

Features ‘ Sketch ‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ g0 _ &5 X
- PPEAPEE ©-o S@-2-
Y
D) A
7 ] @]
% Part1 (Default<<Default>_D FrO nt Pl @
History Q N e B
Sensors
» Em Design Binder { D e
4 Annotations E=
Equations i =]
§5 Material <not specified>
©

R Model ‘ 3D Views ‘ Motion Study 1 ‘

Redeem the access code on the inside cover of the book. Download the SW-TUTORIAL-
2019 folder to your hard drive. Open the Bracket part. Review the features and sketches in
the Bracket FeatureManager.

Activity: Download the SOLIDWORKS folder. Open the Bracket Part.

Download the SOLIDWORKS folder. Open an existing SOLIDWORKS part.

ADE-2- [0k

L\Spen (Ctrl+0)
N Opens an existing document.

19)

20)
21)
22)

Download the SW-TUTORIAL-2019 folder.

Click Open i from the Menu bar menu.
Browse to the SW-TUTORIAL 2019\Bracket folder.

Double-click the Bracket part. The Bracket part is displayed
in the Graphics window.

PAGE 1-12
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J‘%soupwom‘ File Edit View Insert Tools Window Help | O E-S- -u BEs 3 2-_0OX
J° swept Boss/Base ) ® B sweptcet B EE Arb g8 wrap ‘a Y

Extruded Revolved i Lofted Boss/Base  Extruded Hole Revolved m Lofted Cut ~ Fillet Linear E Draft @ Intersect | Reference Curves

Boss/Base Boss/Base cut  Wizard  cut Pattern Geometry
1 7825¢ ) Boundary Boss/Base . @ Boundarycut . . (W shell B Mirror . .

Features Sketch‘ Evaluate‘ MBD Dimensions‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ 00 _=FX

PLENRE © © SR-T-

FeatureManager
design tree

% Bracket (Default<<Default>_[ ~
» History
Sensors
4 Design Binder
Annotations
Solid Bodies(1)
Equations 1
858 Material <not specified>
m Front Plane
[g Top Plane
g Right Plane
I_, Origin

@ Extrude-Thin1

E Fillet1
» [ @5.0 (5) Diameter Hole1 ;
9

|1 ",
< > *Isometric

EIEETH model | 3D Views | Motion Study 1

The FeatureManager design tree is located on the left side of the SOLIDWORKS Graphics
window. The FeatureManager provides a summarized view of the active part, assembly, or
drawing document. The tree displays the details on how the part, assembly or drawing
document was created.

Use the FeatureManager rollback bar to temporarily roll back to an earlier state, to absorbed
features, roll forward, roll to previous, or roll to the end of the FeatureManager design tree.
You can add new features or edit existing features while the model is in the rolled-back state.
You can save models with the rollback bar placed anywhere.

In the next section, review the features in the Bracket FeatureManager using the Rollback bar.

Activity: Use the FeatureManager Rollback Bar option.

Apply the FeatureManager Rollback Bar. Revert to an earlier state in the model.

23) Place the mouse pointer over the rollback bar in the
FeatureManager design tree as illustrated. The pointer changes to a

hand @l-. Note the provided

information on the feature. This is » &) Extrude-Thin1 ' gwu‘jﬂh'm

called Dynamic Reference ® Fillett X @F'"m _ |

Visualization. v [& 25.0 (5) Diameter Hole1 e fpii::?'amew rolet
24) Drag the rollback bar up the L Lpattert o, , %m_o (10) Diameter Hole1

FeatureManager design tree until it is b1 R e el BE | pattern2

above the features you want rolled EE LPattem? v 8 cut-Extrudet

back, in this case 10.0 (10) Diameter » (@ Cut-Extrude1 FE | pattern3

Hole1. EE LPattern3 H 6\_‘

25) Release the mouse button.
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SOLIDWORKS® 2019 Tutorial

View the first feature in the Bracket Part.

26) Drag the rollback bar up the FeatureManager above Fillet1. View the results in the Graphics

window.

Return to the original Bracket Part

FeatureManager.

27) Right-click Extrude-Thin1 in the
FeatureManager. The pop-up
Context toolbar is displayed.

28) Click Roll to End. View the
results in the Graphics window.

Jp’SSOLmWORKs‘ File Edit View Insert Tools Window Help f‘ o0 v@vvgvr)- 8 .8 ?2-_0OX
ﬁ 3 f Swept Boss/Base @ @ ﬁ Swept Cut @ EE @ Rib @ Wrap .ﬂ U

Extruded Revolved i Lofted Boss/Base Extruded Hole Revolved @ Lofted Cut Fillet Linear B Draft @ Intersect Reference Curves |
Boss/Base Boss/Base cut Wizard ¢yt Pattern i Geometry
@ Boundary Boss/Base . @ Boundary Cut | _ . @ Shell Hf\] Mirror

Features ‘ Sketch ‘ Evaluate| MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘

an_-&X

° PLEPEE-©- oS-
$ BElRe[@F
7
» Em Design Binder "
4 mAnnotations
» Solid Bodies(1)
@ Equations
55 Material <not specified>
Ej Front Plane
Ej Top Plane %
Ej Right Plane
I_, Origin

@ Extrude-Thin1 -~

gEk|

g2

° f®

-

 Fillet1 bl
» (& @5.0 (5) Diameter Hole1
EE LPattern1
» [B100 (10) Diameter Hole’
EE LPattern2

Y

A

*Isometric

v

< >

ST Model | 3D Views | Motion Study 1|

?%@@1'41

x .
4 Desigrtmm{:&:
» [A] Annot Feature (Extrude-Thin1)

» Solid E Roll to Previous
Equati‘ Roll tcL%End
Ei Mater Comment
Ej Eront Parent/Child...

Configure Feature

Ijij Top Pl

N [ Right

Origin
> §) Extrud

Delete...
Add to Favorites

Save Selection

& & X
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Heads-up View toolbar AP S T 0R D
SOLIDWORKS provides the user with T

numerous view options. One of the most P RREE © - ®- =
useful tools is the Heads-up View toolbar displayed PLENLE-© &

in the Graphics window when a document is active.

w1

AR Dynamic Annotation Views & : Only available with SOLIDWORKS MBD (Model Based
Definition). Provides the ability to control how annotations are displayed when you rotate
models.

In the next section, apply the following tools: Zoom to Fit, Zoom to Area, Zoom out, Rotate
and select various view orientations from the Heads-up View toolbar.

Activity: Utilize the Heads-up View toolbar.

Zoom to Fit the model in the Graphics window.

29) Click the Zoom to Fit o icon. The tool fits the model to the
Graphics window. \

Zoom to Area on the model in the Graphics window.

30) Click the Zoom to Area el icon. The Zoom to Area e
icon is displayed.

Zoom in on the top left hole.

31) Windows-select the top left corner as illustrated. View the
results.

De-select the Zoom to Area tool.

32) Click the Zoom to Area JD‘ icon.

Fit the model to the Graphics window.

33) Press the f key.

Rotate the model. s soupwores| Fie et view imert Toos winsow e #| (3 ()l @Dk - 8 Fs 8 20 - O
. & 9 I swepttosmue B B @ Bsencw B 5 Jrb EBwe ‘a U
34) Hold the middle mouse button down. Drag |z s 8ttt S e Gt o 8 s
Features | Sketch | Evaluate | MBD Dimensions | SOUDWORKS A I souvwokksvcmv\ oo - > X
upward b, downward b,to the left O R FLAPAE © - @ T
& BloI@IFT
and to the right U to rotate the model in the € sk otatc oo 1~

» History

Graphics window.

> rude-Thin
it
» (3 @5.0 (5) Diameter Hole1 z
| NPy v

< >
SIS Model | 3D Views | Motion Study 1 |
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Display a few Standard Views.

35) Click inside the Graphics window.

36) Click Front @ from the drop-down Heads-up
view toolbar. The model is displayed in the

Front view.

37) Click Right [ from the drop-down Heads-up
view toolbar. The model is displayed in the

Right view.

38) Click Top \» from the drop-down Heads-up
view toolbar. The model is displayed in the Top

view.

Display a Trimetric view of the Bracket model.

SOLIDWORKS® 2019 Tutorial

v B
-

PIEPR

ﬁ Dimetric
>

Trimetric

39) Click Trimetric @ from the drop-down Heads-
up view toolbar as illustrated. Note your options.
View the results in the Graphics window.

SOLIDWORKS Help

Help in SOLIDWORKS is
context-sensitive and in
HTML format. Help is
accessed in many ways,
including Help buttons in all
dialog boxes and
PropertyManager (or press
F1) and Help @ tool on the
Standard toolbar for
SOLIDWORKS Help.

Jp’SsoLlDwoRKs‘ File Edit View Insert Tools Window Hglp 7 | a0 ~Ey~~g~')~w BEE:82-_OX
Y J° Swept Boss/Base =3 m B sweptcst B EZ Jrb &g wrep ‘@ Y

Extruded Revolved ) Lofted Boss/Base  Extruded Hole Revolved (fl Lofted cut  Fillet Linear By prage (D intersect Reference Curves
Boss/Base Boss/Base cut Wizard oyt Pattern Geometry
@ Boundary Boss/Base @ Boundary Cut | ., .

. . (W shell B Mirror
Features | Sketch Evaluate‘ MBD Dimensions‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM a0 _ 5 X

@) Bracket (Default<<Default>_[ ~
» [@]History
[@] sensors
» [17] Design Binder
» [A] Annotations
» [@)Solid Bodies(1)
3 equations ﬂ
858 Material <not specified>
[ Front Plane

E] Top Plane
() Right Plane
I_, Origin
» @) Extrude-Thin1 v
@ Fillet1
» (3250 (5) Diameter Hole1 z‘kx
v

1IN,

< > *Isometric

| EH model 3D Views | Motion Study 1|
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40) Click Help from the Menu bar. el | Y0l -
41) Click SOLIDWORKS Help. The SOLIDWORKS Help Home 2 *Welcome to SOLIDWORKS
Page is displayed by default. View your options. 1D soupworks Herp
- 1 . \ SOLIDWORKS Tutorials
“¥* SOLIDWORKS Web Help is active by default under SOLIDWORKS CAM
Help in the Main menu. AP Help
Search
Close Help. Return to the SOLIDWORKS Graphics window. Re;ea‘e Notes
What's New
42) Close (X | SOLIDWORKS Home. @ Introducing SOLIDWORKS (pdf)
Moving from 2D to 3D
SOLIDWORKS Tutorials
Display and explore the SOLIDWORKS tutorials. Check for Updates...
43) Click Help from the Menu bar. Activate Licenses..
44) Click SOLIDWORKS Tutorials. The SOLIDWORKS Tutorials Deactivate Licenses..
are displayed. The SOLIDWORKS Tutorials are presented by Show Licenses..
category. My Products...
45) Click the Getting Started category. The Getting Started About SOLIDWORKS.
category provides lessons on parts, assemblies, and drawings. Customize Menu

In the next section, close all models, tutorials and view the
additional User Interface tools.

Activity: Close all Tutorials and Models.

Close SOLIDWORKS Tutorials and models.
46) Close Ed SOLIDWORKS Tutorials.
47) Click Window, Close All from the Menu bar menu.

o vt % A0 -»-

Viewport
= New Window

[THEC Y

Cascade

Y E Tile Horizontally
| D] Tile Vertically
Arrange Icons

Close All

User Interface Tools

The book utilizes additional areas of the SOLIDWORKS
User Interface. Explore an overview of these tools in the

next section. ~

1 Part1 *

2 Bracket.SLDPRT

Browse Open Documents...

Customize Menu
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SOLIDWORKS® 2019 Tutorial

Right-click s o G

Right-click in the Graphics window on a Zoom to Fit
model, or in the FeatureManager on a feature |~
or sketch to display the Context-sensitive
toolbar. If you are in the middle of a
command, this toolbar displays a list of
options specifically related to that command.

Zoom to Area
Zoom In/Out
Rotate View
Pan

Roll View

(2L 2o ho)

Rotate About Scene Floor

Set Current View As...

Right-click an empty space in the Graphics
window of a part or assembly, and a
selection context toolbar above the shortcut
menu is displayed. This provides easy access
to the most commonly used selection tools.

View Orientation...

Edit Scene

B

@

Open Drawing
Recent Commands
Contour Select Tool

Customize Menu

SR« @
FC2PLBP

Consolidated toolbar

Similar commands are grouped together in the CommandManager.
For example, variations of the Rectangle sketch tool are grouped in
a single fly-out button as illustrated.

If you select the Consolidated toolbar button without expanding:

For some commands such as Sketch, the most commonly used
command is performed. This command is the first listed and the
command shown on the button.

For commands such as rectangle, where you may want to
repeatedly create the same variant of the rectangle, the last used
command is performed. This is the highlighted command when the
Consolidated toolbar is expanded.

System feedback icon

Select Tangency
% Save Selection
Zoom/Pan/Rotate
Recent Commands
Face
o0 Change Transparency
G Create Plane Parallel to Screen
Feature (Extrude-Thin1)
Comment
Parent/Child...
Configure Feature

Delete...

]

Add to Favorites

% Save Selection
Body

Isolate

Export to DXF / DWG

FeatureWorks...

/-O-1-#
ORe-0-A

[ (I/Z\grner Rectangle

=1 Center Rectangle

Q 3 Point Corner Rectangle
@: 3 Point Center Rectangle
[ Parallelogram

SOLIDWORKS provides system feedback by attaching a
symbol to the mouse pointer cursor. [}

by | [Re

k. ]

The system feedback symbol indicates what you are

Face - Edge'Dimension- - Vertexq|

selecting or what the system is expecting you to select.

As you move the mouse pointer across your model, system
feedback is displayed in the form of a
symbol, riding next to the cursor as
illustrated. This is a valuable feature in
SOLIDWORKS.
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Confirmation Corner

When numerous SOLIDWORKS commands are active, a symbol or a
set of symbols is displayed in the upper right hand corner of the Graphics
window. This area is called the Confirmation Corner.

When a sketch is active, the confirmation corner box displays two
symbols. The first symbol is the sketch tool icon. The second symbol is a
large red X. These two symbols supply a visual reminder that you are in an
active sketch. Click the sketch symbol icon to exit the sketch and to save
any changes that you made.

When other commands are active, the confirmation corner box provides a
green check mark and a large red X. Use the green check mark to execute
the current command. Use the large red X to cancel the command.

w1
“¥* Confirm changes you make in sketches and tools by using the D
keyboard shortcut to move the OK and Cancel buttons to the pointer

location in the Graphics window.

Heads-up View toolbar

SOLIDWORKS provides the user with numerous view options from the
Standard Views, View and Heads-up

Overview of SOLIDWORKS® and the User Interface

© _ =
R
@ -
v
R
v 8

View toolbar.
Standard Views

The Heads-up View toolbar is a

[~
MRS

transparent toolbar that is displayed

in the Graphics window when a View
document is active. |0 g ‘g - -@ @ -

You can hide, move or modify the

Heads-up View toolbar. To modify PPEGPAZKE- - - @R

the Heads-up View toolbar, right-
click on a tool and select or deselect

PRPECHR. ®-Q

the tools that you want to display. \

The following views are available.
Note: available views are document
dependent.

e Zoom to Fit & : Zooms the model to fit the Graphics window.

£ . .
e Zoomto Area ¢ : Zooms to the areas you select with a bounding box.

e  Previous View <& : Displays the previous view.

PAGE 1-19
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o Section View o : Displays a cutaway of a part or

. . DO REE - -® - -0~
assembly, using one or more cross section planes. | ¢ ¢ FOA v g % &=
e  Dynamic Annotation Views ;i‘{ Only available View Selector (C_trl+Spa;B_ar) 3
with SOLIDWORKS MBD. Provides the ability | | &ioceor o chome o o sare of
to control how annotations are displayed when standard andpnonfs;fndard vew L
orientations. Press Alt to expose on
you rotate mOdelS. the back faces of the View ’S)elector.y
The Orientation dialog has an option to display a view cube (in-
context View Selector) with a live model preview. This helps the
user to understand how each standard view orientates the model.
With the view cube, you can access additional standard views.
The views are easy to understand and they can be accessed
simply by selecting a face on the cube.
To activate the Orientation dialog box, press (Ctrl + spacebar) or
click the View Orientation © ~ icon from the Heads up View
toolbar. The active model is displayed in the View Selector in an
Isometric orientation (default view).
Click the View Selector icon in the Orientation dialog box to
show or hide the in-context View Selector.
3
“¥" Press Ctrl + spacebar to activate the View Selector.
3
“¥" Press the spacebar to activate the Orientation dialog
box. EPSRFT TR RURCR Y S=E
e View Orientation box £2 - ; Provides the ability to . v
select a view orientation or the number of viewports. . p @
The available options are Top, Left, Front, Right, e
. . . . 4
Back, Bottom, Single view, Two view - Horizontal, ml=anlzz
Two view - Vertical, Four view. Click the drop-down

arrow to access Axonometric views: Isometric,
Dimetric and Trimetric.

o Display Style @ -. Provides the ability to display the
style for the active view. The available options are
Wireframe, Hidden Lines Visible, Hidden Lines
Removed, Shaded, and Shaded With Edges.
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e Hide/Show Items ® ~: Provides the ability to select items to hide or show in | ® @ & -
the Graphics window. The available items are document dependent. Note the ?' \%
View Center of Mass ¥ icon. M‘

e Edit Appearance @: Provides the ability to edit the appearance of entities of |1
the model. e

D 52

o Apply Scene 22 " Provides the ability to apply a L
scene to an active part or assembly document. =B gﬂzg %"
View the available options. Y A — B

. R . o @ shadows In Shaded Mode =

o View Setting : Provides the ability to select @ Ambient Occusion =
the following settings: RealView Graphics, R Perspective Se
Shadows In Shaded Mode, Ambient Occlusion, @® coroon B o
Perspective and Cartoon.

e Rotate view C : Provides the ability to rotate a
drawing view. Input Drawing view angle and
select the ability to update and rotate center marks
with view. &~ pil ige C g ®-Q

e 3D Drawing View &) : Provides the ability to
dynamically manipulate the drawing view in 3D ¥ @
to make a selection. Options

Changes options settings for

To display a grid for a part, click Options i3 T, SOLIDWORKS.

Document Properties tab. Click Grid/Snaps, check —

the Display grid box. \\‘E Disolay grid

s ! - Dash
‘¥ Add a custom view to the Heads-up View [¥] Automatic scaling
toolbar. Press the space key. The Orientation dialog Major grid spacing: 100.00mm |2
*

box is displayed. Click the New View @ tool. The Minor-fines per major: | 4 z

Name View dialog box is displayed. Enter a new

named view. Click OK. snap points per minor: 1 S

Use commands to display information about the triad

or to change the position and orientation of the triad. G0 T0 System Shaps

Available commands depend on the triad's context.

Y
Triad
\
X
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SOLIDWORKS CommandManager S

The SOLIDWORKS CommandManager is a Context-sensitive < %:z:ize
toolbar. By default, it has toolbars embedded in it based on your
active document type. When you click a tab below the Addtns..
CommandManager, it updates to display that toolbar. For example,
if you click the Sketch tab, the Sketch toolbar is displayed. Button Size

Save/Restore Settings...

" For commercial users, SOLIDWORKS Model Based
Definition (MBD) and SOLIDWORKS CAM is a separate
application. For education users, SOLIDWORKS MBD and
SOLIDWORKS CAM is included in the SOLIDWORKS Education Edition.

Y
-~

Below is an illustrated CommandManager for a Part document. Your tabs may vary
depending on your SOLIDWORKS applications.

J(%SOLIDWORKS ‘ File Edit View Insert Tools Window Help f‘ @ 'B}" g ¢ W)- {@}" Part
— : - o
3 f Swept Boss/Base @ @ ﬁ Swept Cut @ EE @ Rib Wrap 7] U T\E
Extruded Revolved i Lofted Boss/Base Extruded I-!ole Revolved @ Lofted Cut Fillet Linear i} Draft @ Intersect Reference Curves fjngtantap
Boss/Base Boss/Base cut  Wizard ¢ Pattern . Geometry
@ Boundary Boss/Base . @ Boundary Cut | . @ Shell el Mirror . .
Features | Sketch | Evaluate | MBD Dimensions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM LPURPEAE-§-@-&
[ N .
Q <\ / - @ - [U - % @ E [hiﬂ'.] Mirror Entities J@ @ z @
Exit Smart . N - @ - A Trim  Convert Offset EE Linear Sketch Pattern  ~ Display/Delete pepai Rapid |Instant2D
Sketch| Dimension Entities Entities Fnyities Relations  Sketch Sketch
p— @ ol - - - -
Features | Sketch | Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins | SOLIDWORKS CAM | JERO P VR CE -
b <3 g o o d @& & @ Check & Deviation Analysis [ Draft Analysis B symmetry Check c Bt & @
Desf" Interference Measure Markup Mass  Section Sensor Performance () Geometry Analysis NN Zebra Stripes (3 Undercut Analysis =& Thickness Analysis ~ Check Active SimulationXpress  FloXpress  DFMXpress DriveWorksXpreq
Sni ly  Detection View Properties Properties Evaluation @D £ parting Line Analysis [33) Compare Documents DO("_’""‘ Analysis Wizard  Analysis Wizard Analysis Wizard Wizard
Features | Sketch | Evaluate | MBD Dimensions | SOLIDWORKS Add-ns | SOLIDWORKS CAM LPOEPEE-©-©-Sf-T- 00 _ & X &

=)

00 ULt %]
& B B S @
Auto Dimension Location Size  Basiclocation pattern Datum Geometric

Scheme Dimension Dimension Dimension  Featyre Tolerance

Features | Sketch | Evaluate | MBD Dimensions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM

©

e * @ % & € % ¥ El

3DEXPERIENCE CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst SOLIDWORKS

Marketplace 360 Motion Routing Simulation Toolbox Flow Simulation
Features ‘ Sketch ‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ LCLOREERE -

L

A Set button size from the Toolbars tab of the Customize dialog %‘%pﬂons
box. To facilitate element selection on touch interfaces such as
tablets, you can set up the larger Size buttons and text from the
Options menu (Standard toolbar).

Customize...
Add-Ins...

Save/Restore Settings...

N
\Buﬁon Size
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The SOLIDWORKS CommandManager is a Context-sensitive 2N
toolbar that automatically updates based on the toolbar you want to £33 Sptions
access. By default, it has toolbars embedded in it based on your Customize...
active document type. P

W Save/Restore Settings...

2% For commercial users, SOLIDWORKS Model Based
Definition (MBD) and SOLIDWORKS CAM is a separate
application. For education users, SOLIDWORKS MBD and
SOLIDWORKS CAM is included in the SOLIDWORKS Education
Edition.

Button Size

Below is an illustrated CommandManager for a Drawing document.
Your tabs may vary depending on your SOLIDWORKS
applications.

o Il R “ &7

B i & Q@ 55
Standard Model Projected Auxiliary Section Detail Broken-out Break Crop  Alternate
3View View  View View = View View  Section View View Position View

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format

O Ao oF A M D Balloon v/ Surface Finish (5083 Geometric Tolerance © Center Mark =

Smart Model Spell Format Note Linear Note {3 auto Balloon /%< Weld Symbol Datum Feature Blocks £ Centerline  £23 Revision Cloud ~ Tables

Dimension jtems  Checker Painter Pattern ~ A
M Magnetic Line LI® Hole Callout  §a Datum Target . Area Hatch/Fill

View Layout | Annotation | Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format ;

<\ / e @ M N v @ % @ D’H] Mirror Entities J@
smart O~ 0 M @ M THiT Offset EE Linear Sketch Pattern  ~ Display/Delete
Dimension — Entities Entities Relations

e - . . - . .

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format ’:

Abc

v 8 3 B B % &
Spell  Measure Section Performance Compare Check Active DriveWorksXpress
Checker Properties Evaluation Documents Document Wizard

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format

[ s

® @ % & E % ¥ [ <
CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst SOLIDWORKS
360 Motion Routing Simulation Toolbox Flow Simulation

View Layout ‘ Annotation [ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins | Sheet Format

=

- L2
Edit Sheet| Title Block Automatic
Format Fields Border

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate | SOLIDWORKS Add-Ins ‘ Sheet Format

View Layout
Annotation
Sketch

.-

* To add a custom tab, right-click on a tab and click
Customize CommandManager. You can also select to add a blank
tab and populate it with custom tools from the Customize dialog

box. ~

s
-~
Evaluate

SOLIDWORKS Add-Ins

Sheet Format

Use Large Buttons with Text

Vel <T<T<T<T <]

Customize CommandManager...
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The SOLIDWORKS CommandManager is a Context-sensitive SR

toolbar that automatically updates based on the toolbar you want to £33 Bptions
access. By default, it has toolbars embedded in it based on your
active document type.

Customize...

Add-Ins...

e Save/Restore Settings...

2 For commercial users, SOLIDWORKS Model Based

Definition (MBD) is a separate application. For education users, Button Size

SOLIDWORKS MBD is included in the SOLIDWORKS Education
Edition.

Below is an illustrated CommandManager for an Assembly
document. Your tabs may vary depending on your SOLIDWORKS applications.

By o ° _
(S it B O & ‘@ B ¢ BON %
Insert  Mate Linear Component  smart Move Assembly Reference New Motion | Bill of  Exploded [jnstant3D| Update | Take Large Assembly
Components Pattern Fasteners Component Features Geometry  Sudy  Materials  View Speedpak|Snapshot  Mode
Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | M8D | PPAPRB O - ©-@L-T-
g <& /O NV- # U [kl Mirorenes 1o @2 A9 Make Block 3
Create Smart [ Sy (D)~ A\ Tim Convert offset EF Linear Sketch attem - Display/Delete Repair (48 save sketch Insert
layout Dimension Entities Entities ptities Relations  Syetch - Components
- *® W&ol "o ° . - A insert Block "
Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | MBD | POEPEEP - © - ©-C & @
OV © Barmsen . =
o o o i
Q, <\ % @ C | irror Entities & z o
Exdi _Smar_t .- 0 v @ < Ir_"]” Corjv_ert Offset EE Linear Sketch Pattern ~ ~ Dlsplay/_DeIete Repair Rapid |Instant2D
Sketch| Dimension . Entities Entities Epgities Relations  gyetch Sketch
. . - -w| L = . .
& A9 G
Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | MBD et
.
W ok @ 0 e S @ & n B o t & -] /=] (2]
Design |nterference Clearance  Hole  Measure Markup Mass  Section Sensor Assembly Performance Curvature Symmetry Compare Check Active FloXpress  Dr
Study Detection Verification Alignment View Properties Properties Visualization ~Evaluation Check  Documents Document t Analysis Wizard Analysis Wizard ~ Wizard  Costing
Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-ins | MBD | PLEAPZEEB - © -« SR -T-

® @ % & E % T KL <

3DEXPERIENCE CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst SOLIDWORKS

Marketplace 360 Motion Routing Simulation Toolbox Flow Simulation
Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | MBD| PLIEAPRE ©-®- 4
A4 DY ~A P P o B A @@ M e & 2 i£]
Import Datum Surface Weld Note Balloon Stacked ~Smart  Bill of Tables Capture Section Model Exploded  Dynamic 3DPDF  Publishto
Scheme Target Finish Symbol Balloons Dimension Materials 3DView View Break View View Annotation Views Template Editor 3D PDF
Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-ins | MBD PLORDEE-§-©-SP-0- 00 - 9

By default, the illustrated options are selected in the Customize box [

Toobars  ShortcutBars Commande  Menus Keybosrd  Mouse Gestures  Customization

for the CommandManager. Right-click on an existing tab and click | = #e==

Search for

Customize CommandManager to view your options. =
1 e s
= = I open.
‘¥ You can set the number of mouse gestures to 2, 3,4, 6, 8, or O

nnnnnnnnn

12 gestures. If you set the number to 2 gestures, you can orient
them vertically or horizontally. T —

Pint Gesture Guides.

Resetto Defauts
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Float the CommandManager. Drag the Features, Sketch or any
CommandManager tab. Drag the CommandManager anywhere on
or outside the SOLIDWORKS window.

To dock the CommandManager, perform one of the following:

While dragging the CommandManager in the SOLIDWORKS
window, move the pointer over a docking icon -

Dock abave Dackleft Dockright and click the needed

command.

Double-click the floating CommandManager to revert the
CommandManager to the last docking position.

Screen shots in the book were made using SOLIDWORKS 2019
SPO running Windows® 10.

Selection Enhancements

Right-click an empty space in the Graphics window of a part or
assembly; a selection context toolbar above the shortcut menu
provides easy access to the most commonly used selection tools.

e Box Selection :--. Provides the ability to select entities in parts,
assemblies, and drawings by dragging a selection box with the
pointer.

e Lasso Selection <. Provides the ability to select entities by
drawing a lasso around the entities.

e Selection Filters ?}'. Displays a list of selection filter
commands.

o Select Other . Displays the Select Other dialog box.
o Select . Displays a list of selection commands.

e Magnified Selection (. Displays the magnifying glass, which
gives you a magnified view of a section of a model.
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CommandManager

@ Extruded Boss/Base
§ Revolved Boss/Base
f Swept Boss/Base
i Lofted Boss/Base
@ Boundary Boss/Base
Extruded Cut

@ Hole Wizard

@ Revolved Cut

ﬁ Swept Cut

m Lofted Cut

@ Boundary Cut

B Fillet

EE Linear Pattern

4 Rib

E Draft

(W shell

Wrap

@ Intersect

i"tﬂ Mirror

eiii Reference Geometry

U Curves

‘D\u Instant3D

SOLIDWORKS CAM ~ SOLIDWORKS Add-Ins  MBD Dimensions |Evaluate [Sketch |Features [

—

hs e #ING

Zoom to Fit
Zoom to Area
Zoom In/Out
Rotate View
Pan

Roll View

QLA

Set Current View As...
View Orientation...

Edit Scene

<

Open Drawing
Recent Commands

Contour Select Tool

Customize Menu

Rotate About Scene Floor

»
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w s

2 Save space in the CommandManager, right-click in the =
CommandManager and un-check the Use Large Buttons with % 3°mra"d:2ager —
Text box. This eliminates the text associated with the tool. e arge B M e

Customize...
o D 2Dto 3D
“¥" DimXpert provides the ability to graphically check if the {& 3owox
model is fully dimensioned and toleranced. DimXpert " Align

automatically recognizes manufacturing features. Manufacturing
features are not SOLIDWORKS features. Manufacturing features
are defined in 1.1.12 of the ASME Y 14.5M-1994

Dimensioning and Tolerancing standard. See

SOLIDWORKS Help for additional information. G ER ¢ @F
¢
- ‘% Bracket (Default<<Default>_[ *
FeatureManager Design Tree ) istoy
1 o . Sensors
The FeatureManager consists of various tabs: =P~
. @a » Annotations
o FeatureManager design tree ¥ tab. » [igi) Solid Bodies(1)
Equations
o PVOpeI"lyManagel” E tab. §5 Material <not specified>
ﬂ Front Plane
o ConfigurationManager B tab. EJJ Top Plane &
Right Plane
* Dln/LXpertManager $‘ tab . %S;?JZe-Thim ‘Hide FeatureManager Tree Area
e DisplayManager @ tab. ® %Ske““
Fillet1
< . : .
o CAM FeatureManager tree S+ 1* tab, G250 5 Diameter Holt
C Sketch3
= C Sketch2
J EE LPattern1
Click the direction arrows to expand or ~ 22100 (10) Diameter Hole’
collapse the FeatureManager design tree. %Ste“:s y
Sketch4
Tabs will vary depending on your % itz ZJ\K
SOLIDWORKS applications and Add- SE—
ins.
. E | 1S Blo|I@F
Select the Hide/Show FeatureManager $ klo/@ | Soncor @
;[g ' &) @ FLATBAR-DesignTable (Def|||” * ™
Areatab | @ as illustrated to enlarge the ~ History Sensor Type ~
Graphics window for modeling. Sensors 2 Mass propertes v
s v [ Des Add\Sensor... Properties ~
_/'Q\_ . v [AlA Noj?i}cations... L2 (e =
The Sensors tool located in the nr _ &
FeatureManager monitors selected > [@]soli  Rename tree item

properties in a part or assembly and alerts

you when values deviate from the

specified limits. There are five sensor types:

Simulation Data, Mass properties, Dimensions, Measurement and
Costing Data.

Value : 0.0113609512 Ib

alert 2
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Various commands provide the
ability to control what is displayed
in the FeatureManager design tree.

System Options - Document Properties

General

MBD

Drawings
Display Style
Area Hatch/Fill
Performance

Colors

Sketch Hide/show tree items

1. Show or Hide FeatureManager

Relations/Snaps

: [[Eelocks
Display
1tems. selection
Performance [EIesign Binder
| (Assemblies
o External References [AJAnnotations
_/QC . . @ Default Templates
File Locations i
Click Opti from th st s
1C p ons Y t S FeatureManager @

Spin Box IndfRgents
View
Backup/Recover
Touch

Hole Wizard/Toolbox
File Explorer

Search

[@Jsurface Bodies

[Eables

Menu bar. Click FeatureManager
from the System Options tab.
Customize your FeatureManager
from the Hide/Show tree Items
dialog box.

[SFavorites

Collaboration ~
Messages/Errors/Warnings JeDraving Markups
Import

Export [ selection Sets

[EZMarkups

2. Filter the FeatureManager design

Reset.

LI Allow component Tiles 1o be renamea Trom Featurenanager tree

Enable preview of hidden components
Edit name with slow double click

Automatic

Show

Show

Automatic

Automatic

Automatic

Automatic

Show

Automatic

Automatic

Show v

N [EJequations

~ = Sh v
SogMaterial ow

Show =

- [ Default Planes

v 1, origin

[ Mate References

v Gk Design Table

e [Esensors

Show hd
Automatic v
Automatic .
Show i
Show hd

~ [@History

Automatic .

v [@]6raphic Bodies

tree. Enter information in the filter
field. You can filter by Type of
features, Feature names, Sketches, Folders, Mates, User-
defined tags and Custom properties.

w1

“¥" Tags are keywords you can add to a
SOLIDWORKS document to make them easier to filter
and to search. The Tags “* icon is located in the bottom
right corner of the Graphics window.

w1

A Collapse all items in the FeatureManager, right-
click and select Collapse items, or press the Shift + C
keys.

The FeatureManager design tree and the Graphics
window are dynamically linked. Select sketches,
features, drawing views, and construction geometry in
either pane.

Split the FeatureManager design tree and either display
two FeatureManager instances, or combine the
FeatureManager design tree with the
ConfigurationManager or PropertyManager.

Move between the FeatureManager design tree,
PropertyManager, ConfigurationManager,
DimXpertManager, DisplayManager and others by
selecting the tab at the top of the menu.

Tabs will vary depending on your SOLIDWORKS
applications and Add-ins.
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The ConfigurationManager I3 tab is located to the right of the

PropertyManager £ B tab. Use the ConfigurationManager to
create, select and view multiple configurations of parts and
assemblies.

The icons in the ConfigurationManager denote whether the
configuration was created manually or with a design table.

The DimXpertManager & tab provides the ability to insert
dimensions and tolerances manually or automatically. The
DimXpertManager provides the following selections: Auto

Dimension Scheme @, Auto Pair Tolerance, Basic,
Location Dimension | Basic Size Dimension
General Profile Tolerance % , Show Tolerance Status +®

Copy Scheme % , Import Scheme D and TolAnalyst Study

SOLIDWORKS® 2019 Tutorial

@
WConfigu:a'tionManagerl
~ & @ FLATBAR-DesignTable Con

v [ETables

|  Default [ GIDS-sC-100(

| — 3HOLE [ GIDS-SC-1000
| = 5HOLE [ GIDS-SC-1000
| = 7HOLE [ GIDS-SC-1000

%\IH%\%O\ [

Fly-out FeatureManager

The fly-out FeatureManager design tree
provides the ability to view and select items in
the PropertyManager and the FeatureManager
design tree at the same time.

v X

Direction 1

@G LN
D\
> ® rLATBAR DesignTa
%‘|E‘$‘e“§?\: History
EE LPattern1 @ [&] sensors

’ Design Binder
N - » [A& Annotations

‘Edged)

Throughout the book, you will select commands

‘ 4 Sol|d Bodies(1)

- [Z] Equations

and command options from the drop-down
menu, fly-out FeatureManager, Context toolbar,
or from a SOLIDWORKS toolbar. €3 0.500in
w e =5 9

" Another method for accessing a command
is to use the accelerator key. Accelerator keys

Direction 2

® Spacing and instances
O Up to reference

Features and Faces

o:ﬁ 6061 Alloy
Gj Front Plane

m Top Plane
Ej Right Plane

I_. Origin
4 éﬂ Boss-Extrude1
~ v @

ut-Extrude

»

Ei
D*i

<

»

q

are special key strokes, which activate the drop- &
down menu options. Some commands in the

Cut-Extrude1

LPattern

menu bar and items in the drop-down menus @
have an underlined character.

[(Jeodies
Instances to Skip

Options
Vary sketch

properties

|:| Geometry pattern
Propagate visual

O Full preview
@ Partial preview

A
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Task Pane

The Task Pane is displayed when a SOLIDWORKS session starts. You can show, hide,
and reorder tabs in the Task Pane. You can also set a tab as the default so it appears
when you open the Task Pane, pin or unpin to the default location.

The Task Pane contains the following default tabs:

e SOLIDWORKS Resources ﬁ.

3 [ ® 5 0 & >

e Design Library iy

e File Explorer [ « co)
; - * o
o View Palette B3 @@ GO
E esign Library
e Appearances, Scenes and Decals @ @ T Toolbox
= = Vv 3D ContentCentral
e  Custom Properties &=l I~ ?%Supp“er e
e SOLIDWORKS Forum "2  @user Loy
: ® . B SOLIDWORKS Content
o
‘¥ Additional tabs are displayed with Add-Ins. %

Use the Back and Forward buttons in the Design Library tab
and the Appearances, Scenes, and Decals tab of the Task Pane & 335
to navigate in folders.
£ Welcome to SOLIDWORKS

SOLIDWORKS Resources

SOLIDWORKS Tools &

Jie

@ Property Tab Builder

The basic SOLIDWORKS Resources B menu displays the
following default selections:

@ SOLIDWORKS Rx

Performance Benchmark Test

Compare My Score

o Welcome to SOLIDWORKS.

e

#% Copy Settings Wizard

e SOLIDWORKS Tools. % My Products

Online Resources &
@ 3DEXPERIENCE Marketplace

e  Online Resources.

t Partner Solutions

e Subscription Services.

Subscription Services &

Other user interfaces are available during the initial software
installation selection: Machine Design, Mold Design, Consumer
Products Design, etc.

@ Subscription Services
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Design Library

The Design Library W contains reusable parts, assemblies, and

other elements including library features.

The Design Library tab contains four default selections. Each

default selection contains additional sub categories.
The default selections are:

e Design Library.

e Toolbox.

o 3D ContentCentral (Internet access required).

e  SOLIDWORKS Content (Internet access
required).
2% Activate the SOLIDWORKS Toolbox. Click
Tools, Add-Ins.., from the Main menu. Check the
SOLIDWORKS Toolbox Library and
SOLIDWORKS Toolbox Utilities box from the
Add-ins dialog box or click SOLIDWORKS
Toolbox from the SOLIDWORKS Add-Ins tab.

To access the Design Library folders in a non-

network environment, click Add File Location il
and browse to the needed path. Paths may vary
depending on your SOLIDWORKS version and
window setup. In a network environment, contact
your IT department for system details.

File Explorer

File Explorer [ duplicates Windows Explorer from

your local computer and displays:
e  Recent Documents.

o Samples.

e Open in SOLIDWORKS.

e Desktop.
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b
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Search

The SOLIDWORKS Search box is displayed in the upper right
corner of the SOLIDWORKS Graphics window (Menu Bar
toolbar). Enter the text or key words to search.

New search modes have been added to SOLIDWORKS
Search as illustrated.

View Palette

The View Palette 3 tool located in the Task Pane provides
the ability to insert drawing views of an active document or
click the Browse button to locate the desired document.

Click and drag the view from the View Palette into an
active drawing sheet to create a drawing view.
R

AR The selected model is FLATBAR-DesignTable in the
illustration.
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Appearances, Scenes, and Decals

Appearances, Scenes, and Decals @ provide a simplified
way to display models in a photo-realistic setting using a
library of Appearances, Scenes, and Decals.

An appearance defines the visual properties of a model,
including color and texture. Appearances do not affect
physical properties, which are defined by materials.

Scenes provide a visual backdrop behind a model. In
SOLIDWORKS they provide reflections on the model.
PhotoView 360 is an Add-in. Drag and drop a selected
appearance, scene or decal on a feature, surface, part or
assembly.

Custom Properties

The Custom Properties = tool provides the ability to enter
custom and configuration specific properties directly into
SOLIDWORKS files.

SOLIDWORKS Forum

Click the SOLIDWORKS Forum "2 icon to search directly
within the Task Pane. An internet connection is required.
You are required to register and to log in for postings and
discussions.

User Interface for Scaling High Resolution
Screens

The SOLIDWORKS software supports high-resolution, high-
pixel density displays. All aspects of the user interface respond
to the Microsoft Windows® display scaling setting. In dialog
boxes, PropertyManagers, and the FeatureManager design tree,
the SOLIDWORKS software uses your display scaling setting

to display buttons and icons at an appropriate size. Icons that are

associated with text are scaled to a size appropriate for the text.
In addition, for toolbars, you can display Small, Medium, or
Large buttons. Click the Options drop-down arrow from the
Standard Menu bar, and click Button size to size the icons.
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Motion Study tab

Motion Studies are graphical simulations of motion for an assembly. Access the
MotionManager from the Motion Study tab. The Motion Study tab is located in the bottom
left corner of the Graphics window.

H]

12 sec
N

Basic Motion V‘ﬁl» > '—"%‘ﬁ‘ ‘@%\K (% v
0 sec 1 sec 2 sec 3 sec |4 sec 5 sec 6 sec 7 sec 8 sec 9 sec 10 sec 11 sec

Eﬁ}ﬁ%%, ‘\H\\HH‘HH\HH‘H\\\HH‘HH\HH‘HH\HHHH\HH|\H\\HH‘IHW\H‘HHM\H‘\H\\HH‘HH\HH‘HHWH

QN ~ @MotionSt

@Orieni

4 Lights

—Q Linear|

3|

13 seq

o Gravit|
v » |8 ) tah

<
- Model | 3D Views | Motior Study 1 |

L a & = o o 2

Incorporate visual properties such as lighting and camera
perspective. Click the Motion Study tab to view the
MotionManager. Click the Model tab to return to the
FeatureManager design tree.

The MotionManager displays a timeline-based interface and
provides the following selections from the drop-down menu as
illustrated:

o Animation: Apply Animation to animate the motion of an
assembly. Add a motor and insert positions of assembly
components at various times using set key points. Use the
Animation option to create animations for motion that do not
require accounting for mass or gravity.

e Basic Motion: Apply Basic Motion for approximating the
effects o.f mOtors, Springs, collisions apd gravity on ~N S
assemblies. Basic Motion takes mass into account in 2 oo g cop—

Screen Capture

calculating motion. Basic Motion computation is relatively e
fast, so you can use this for creating presentation animations o
using physics-based simulations. Use the Basic Motion ~

option to create simulations of motion that account for mass,

collisions or gravity.

50 201030

w1

“¥* If the Motion Study tab is not displayed in the Graphics
window, click View > Toolbars > MotionManager from the
Menu bar.
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3D Views tab

SOLIDWORKS MBD (Model Based Definition) lets you
create models without the need for drawings giving you an
integrated manufacturing solution. MBD helps companies
define, organize, and publish 3D product and manufacturing
information (PMI), including 3D model data in industry
standard file formats.

Create 3D drawing views of your parts and assemblies that
contain the model settings needed for review and
manufacturing. This lets users navigate back to those settings as
they evaluate the design.

Use the tools in the SOLIDWORKS MBD CommandManager
to set up your model with selected configurations, including
explodes and abbreviated views, annotations, display states,
zoom level, view orientation and section views. Capture those
settings so that you and other users can return to them at any
time using the 3D view palette.

To access the 3D View palette, click the 3D Views tab at the
bottom of the SOLIDWORKS window or the SOLIDWORKS
MBD tab in the CommandManager. The Capture 3D View
button opens the Capture 3D View PropertyManager, where
you specify the 3D view name, and the configuration, display
state and annotation view to capture. See SOLIDWORKS help
for additional information.

Dynamic Reference Visualization

SOLIDWORKS® 2019 Tutorial

Capture 3D View

Sort order:

History

Update Previews

ke

m Model \SD Views \ Motion Study 1

b3

RKS Add-Ins |

Features

v | Sketch
Sketch Ink
Surfaces
Sheet Metal
Weldments
Mold Tools
Mesh Modeling
Data Migration
Direct Editing

v | Evaluate
¥ | MBD Dimensions

Render Tools
SOLIDWORKS Add-Ins
MBD
SOLIDWORKS CAM
3DWOX
SOLIDWORKS CAM TBM (Mill)
SOLIDWORKS CAM TBM (Turn)
Analysis Preparation

Use Large Buttons with Text

Customize CommandManager...

(Parent/Child) S EFEE Jal
Dynamic Reference Visualization provides the ability to g T T et————
view the parent/child relationships between items in the History
FeatureManager design tree. When you hover over a Sensors
feature with references in the FeatureManager design » [T Design Binder
tree, arrows display showing the relationships. If a » [&] Annotations
reference cannot be shown because a feature is not » [@]Solid Bodies(1)
expanded, the arrow points to the feature that contains SUEn
the reference and the actual reference appears in a text 62 6061 Alloy
box to the right of the arrow. W il
E] Top Plane
E] Right Plane
I_, Origin
.
v [@ cut-Extrude1 +—Sketch2
BE LPattern1
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Use Dynamic reference visualization for a Vieygnsert Tools Window Help # | Y [)-F-&-&-") [0 B
part, assembly and ever mates. B2 vy it

Screen Capture
To display the Dynamic Reference Display
Visualization, click View » User Interface [Ag:(fyd -
» Dynamic Reference Visualization

Parent/Child) from the Main menu bar.

Hide / Show

Toolbars 0 g
Workspace >

User In e
Mouse Movements B

& Touch
:D: Full Screen F11

> | ¥ | FeatureManager Tree Area

(59| Dynamic Reference Visualization (Parent)
A mouse typically has two buttons: a primary g Dyramic Reference Visulztion (Cil)
button (usually the left button) and a

secondary button (usually the right button).
Most mice also include a scroll wheel
between the buttons to help you scroll through
documents and to Zoom in, Zoom out

and rotate models in SOLIDWORKS. It @
is highly recommended that you use a . [
mouse with at least a Primary, Scroll = L

o = ———”
ey e | r, %

and Secondary button. R

Customize Menu

¥ | Task Pane
¥ | MotionManager

v | Status Bar

-
e
P
Single-click

To click an item, pOil’lt to the item on (1) Primary button (2) scroll wheel {3) Secondary button
the screen, and then press and release

the primary button (usually the left button). Clicking is most often used to select (mark) an
item or open a menu. This is sometimes called single-clicking or left-clicking.

Double-click

To double-click an item, point to the item on the screen, and then click twice quickly. If the
two clicks are spaced too far apart, they might be interpreted as two individual clicks rather
than as one double-click. Double-clicking is most often used to open items on your desktop.
For example, you can start a program or open a folder by double-clicking its icon on the
desktop.

Right-click

To right-click an item, point to the item on the screen, and then press and release the
secondary button (usually the right button). Right-clicking an item usually displays a list of
things you can do with the item. Right-click in the open Graphics window or on a command in
SOLIDWORKS, and additional pop-up context is displayed.

Scroll wheel

Use the scroll wheel to zoom-in or to zoom-out of the Graphics window in SOLIDWORKS.
To zoom-in, roll the wheel backward (toward you). To zoom-out, roll the wheel forward
(away from you).

PAGE 1-35



Overview of SOLIDWORKS® and the User Interface SOLIDWORKS® 2019 Tutorial

Summary

The SOLIDWORKS (Ul) is designed to make maximum use of the Graphics window for
your model. Displayed toolbars and commands are kept to a minimum.

SOLIDWORKS provides a new icon style. It also allows vector-based scaling for
superior support of high resolution high pixel density displays. The new icon style
standardized the perspective of icons. It removes non-essential details, and emphasizes
primary elements. Consistent visual styling applies to all icons.

The SOLIDWORKS User Interface and CommandManager consist of the following main
options: Menu bar toolbar, Menu bar menu, Drop-down menus, Context toolbars,
Consolidated fly-out menus, System feedback icons, Confirmation Corner and Heads-up
View toolbar.

The default CommandManager Part tabs control the display of the Features, Sketch,
Evaluate, DimXpert and SOLIDWORKS Add-Ins toolbars.

The FeatureManager consists of five default tabs:

e FeatureManager design tree.

e PropertyManager.

e ConfigurationManager.

e DimXpertManager.

e DisplayManager.

You learned about creating a new SOLIDWORKS part and opening an existing
SOLIDWORKS part along with using the Rollback bar to view the sketches and features.

Opening a SOLIDWORKS document from an earlier release can take extra time. After
you open and save a file, subsequent opening time returns to normal. Use the
SOLIDWORKS Task Scheduler (SOLIDWORKS Professional) to convert multiple files
from an earlier version to the SOLIDWORKS 2019 format. Click Windows Start > All
Apps » SOLIDWORKS 2019 » SOLIDWORKS Tools 2019 > SOLIDWORKS Task
Scheduler.

o Overall drafting standard
e R

If you modify a document property from an Overall drafting | ANSI-MODIFIED

standard, a modify message is displayed as illustrated.

Derived from: ANSI
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Templates are part, drawing and assembly documents which include user-defined
parameters. Open a new part, drawing or assembly. Select a template for the new
document.

e Parts. The Parts default template is located in the
C:\ProgramData\SolidWorks\SOLIDWORKS 2019\templates\Part.prtdot folder.

e Assemblies. The Assemblies default template is located in the
C:\ProgramData\SolidWorks\SOLIDWORKS 2019\templates\Assembly.asmdot
folder.

e Drawings. The Drawings default template is located in
the C:\ProgramData\SolidWorks\SOLIDWORKS
2019\templates\Drawing.drwdot folder.

In Chapter 2, obtain the working familiarity of the following
SOLIDWORKS sketch and feature tools: Line, Circle,
Centerpoint Straight Slot, Smart Dimension, Extruded
Boss/Base, Extruded Cut and Linear Pattern.

Create three individual parts: AXLE, SHAFT- Q
COLLAR and FLATBAR.

Create the assembly, LINKAGE using the three /
created parts and the downloaded sub-assembly -

AirCylinder.

w1

“¥" Times in academic integrity cases. Right-
clicking on a sketch or feature. Select properties
from the pop-up menu. View who created the
sketches and features in a SOLIDWORKS
model, and when (date + time).
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Notes:
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